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1. WPROWADZENIE

W ¢wiczeniu zostanie zaprezentowany sposob modelowania przeptywu ptynu
scisliwego pod i naddzwigkowego. Zagadnienie zostanie zaprezentowanie na przyktadzie
optywu ptata NACA2418. Plat o dlugosci cigciwy 1 m jest oplywany powietrzem
0 temperaturze 20°C. Oplyw odbywa si¢ dla trzech liczb Reynoldsa: 50 000, 500 000 oraz
5 000 000. Schemat analizowanego przypadku przedstawiony jest na rys. 1.

Wilot
powietrza
U =f(Re)
t=20°C

Profil
NACA2418

0,000 4,500 9,000 (m)
IS
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Rys. 1. Schemat zagadnienia optywu ptata NACA2418 powietrzem



2. OPLYW PROFILU NACA2418
2.1. PRZYGOTOWANIE GEOMETRII
Wykonaj nastepujace zadania:
1) Otwdrz program Ansys Workbench i zapisz projekt o nazwie Cw7 w katalogu
0 nazwie Cw7 (File->Save As).
ZASADA PRAKTYCZNA NR 1: Dla kazdego projektu tworzymy osobny
katalog
ZASADA PRAKTYCZNA NR 2: W nazwach katalogow nie stosujemy: spacji,
znakow specjalnych (np. @#$%"&* itp.) oraz polskich znakow
Product & CAD Configuration 19.2
- Reaction Workbench 19.2
RSM Cluster Monitoring 19.2
RSM Configuration 19.2

RSM Job Monitoring 19.2

SCDM 19.2

0 Uninstall ANSYS 19.2

'A‘ User License Preferences 19.2
'A‘ Workbench 19.2
l ANSYS, Inc. License Manager

a Aparat

B AutocaD 2019 — polski (Polish)

. Autodesk

B

Bubble Witch 3 Saga

Candv Criich Sada Sana

m Y 8 £ %

_—

2) Wybierz modut Mesh i otworz program Spaceclaim. W tym celu chwy¢ lewym
przyciskiem myszy (LPM) modutl Mesh i przeciaggnij go do pola Project
Schematic. Nastepnie kliknij dwukrotnie LPM na Geometry w celu
uruchomienia programu Spaceclaim, w ktorym zostanie utworzona geometria.
Zwré¢ uwage, ze w lewym dolnym rogu ekranu pojawia si¢ napis informujacy
jaki program jest uruchamiany.
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3) W zaktadce Assembly wybierz ikone File, a nastepnie wskaz dotagczony do
¢wiczenia plik NACA2418.txt
Design Display Measure

4)
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Tools
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Kliknij LPM ikong¢ Select New Sketch |gf|w celu wybrania plaszczyzny

rysowania.

Wybierz ptaszczyzne X-Y jak na rysunku ponizej.

(o) m|2][=

4

Select Hew Skelch Plane

Click an object to cnent the
skeich gnd along the obpect

) Press F for more help.

KeyShot

p
m @ |
Typ
Folder p
Folder p
Dokume

ANSYS 2

Dokume

Anuluj



f;\
. e . .
5) Kliknij ikong Plan View |—J w celu obrocenia ptaszczyzny rysowania
6) rownolegle do ekranu (mozesz tez to zrobi¢ weiskajac Shift + v).

o=)4) =

' Plan View (V)
Display your design 50 that you are viewing the
x=5.9589 y= = guahelam :
¥ Press F1 for more help, or F3 for a video.

7) W panelu u gory ekranu wybierz ikone rysowania linii A narysuj linie w
poblizu krawedzi sptywowej profilu w celu jego domknigcia.




Snapping to Endpoin

NS

%0° |

=

-

o)[=) 4] =]

N\ Design1* x |

Pamigtaj, ze w razie niepowodzenia w kazdym momencie mozesz klikna¢ ikong

) .
cofnigcia (znajduje si¢ w lewym gornym rogu ekranu) lub Ctrl + z.

8) W celu wyj$cia z polecenia rysowania linii naci$nij klawisz Esc i LPM kliknij
ikong przejscia do rysowania 3D widoczng u dotu ekranu.

[o]=](2)=)
Retum to 3D mode

0 Activate the Pull tool in 3D
mode.

& Press F1 for more help.

9) W zakladce Design wybierz Fill, a nastepnie zaznacz caly profil przez
przeciagnigcie LPM
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Select Pull Move | Fill

Edit

@ 2 Split Body 0 &
et & Split i
8 omane G%ijer.t ™ Lf:

" @ Shell ) 3 cytincer
873 @ Offset _
§§§ [ﬂﬁMirror Eguation o Sphere

Intersect Create Body

Select faces or edges to try to remove them. Select a closed loop of lines to create a patch

- X

. P

10) Wybierz Complete

Cap planar region with

&)

v

a surface

Complete (Enter)

Complete the Fill
J operation.

- X

o be -

z

Przeciagnij kursor
ruchem uko$nym przy
wecisnietym LPM

ANSYS

_______

11) Wybierz ptaszczyzne rysowania szkicu na jednej z powierzchni bocznych

profilu

2020 R1



12) Narysuj pozioma lini¢ o dtugosm 150 mm wychodzch z czubka proﬁlu

Snapping to Parallel to Gﬂd Dmhenscon Value

............................ e

!
t
i

M\ Design1* x |
13) Narysuj okrag o $rednicy 12000 mm zaczepiony w prawym koncu linii




Snapping to Grid
W
4

@ 12000

(o[a)[2] =)

| A\ Design x|
14) Narysuyj lini¢ o dlugosci 12000 mm umiejscowiong nad profilem i styczna do
okregu



Snapping to Tangent to Curve, Parallel to Grid, Dimension Value

I\ Design1® x

15) Podobng lini¢ utworz pod profilem



napping to Dimension Value, Parallel to Grid, Parallel to Curve, Tangent to Curve
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16) Domknij profil

Snapping to Grid

‘?’ 2020 R1
&
Y
;—v X 12000mm
: 50°]
+ Bt ¥
‘ g )X

(o) ) &
17) Wybierz ikone¢ Trim away i usun zaznaczony na czerwono kawatek okregu
przez wskazanie go LPM



Select Pull Move Fill Combine o i ' » oo i Equation Sphere
- ES & Project . ags ﬁﬁerror O

Edit Intersect Create Body

OO YXN # % @ & split Body & o @shel Cylinder
0o o VA= @ kékg@%sw p'gjgg’o&azay
D @ zZ 9

Mode

(o])(m] 2] =]

18) Wskaz LPM niepotrzebn:c}‘juz linile; wewnatrz profilu i nacis$nij klawisz Delete

Select 1 sketch curve

ANSYS

2020 R1

(o)(m4]s
19) Wréé do widoku 3D i wybierz polecenie Pull, a nastgpnie wyciagnij utworzony
profil na 200 mm.
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20) LPM wskaz profil i naci$nij Delete w celu jego usunigcia.



21) W ¢wiczeniu zostanie utworzona siatka heksagonalna. Do jej utworzenia
potrzebne sa linie, ktdore wyznacza poszczegolne ,,bloki” siatki. Do ich

utworzenia wykorzystamy ikone Split S w zaktadce Design. Po jej
wybraniu wskaz duza, ptaska powierzchni¢ zaznaczong na z6tto



Click on a face to be split

I\ Design1* x
22)Zbliz si¢ kursorem do krawedzi sptywu i wybierz gorny wierzchotek —
przecigcie zostaje utworzone




23) Podobnie uczyn z dolnym wierzchotkiem — jesli nie pojawia si¢ niebieskie tlo z
widoczng linig przecinajaca, upewnij si¢, ze jest wybrana opcja Select UV cutter
point

Click a point on an edge to split from

s

B

Nsys x 4 b x

24) Nastepnie wybierz ponizszg ptaszczyzne i wierzchotek od czesci okregu

[ ANSYS |

2020 R1

25) Podobnie utworz przecigcie pod profilem



Click a point on an edge to split from

’ Y

I
26) Podobne krawgdzie tngce nalezy wykona¢ z drugiej strony geometrii. Mozna to

zrobi¢ poprzednig metoda lub ponizszg przy wykorzystaniu polecenia Project
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Edit Intersect Create Body
Project
Select 1 or more faces or lines to project € Selectaface, surface, edge, or

note text to project its edges
perpendicularly. Alt+click
another face or edge to set the
projection direction.

o Press F1 for more help.

4

27) Przy wecisnigtym klawiszu Ctrl wybierz weze$niej utworzone krawedzie



Select 1 or more faces or lines to project

S W ()

Y
3

28) Wybierz kierunek rzutowania przez wskazanie ptaskiej powierzchni



Pick a direction to project in

&)
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29) Wybierz duza ptaska powierzchni¢ jako plaszczyzng rzutowania i zatwierdz
Complete



Pick faces to limit the projection to. Exit the tool to finish the

e
30) Zamknij program Spaceclaim i zapisz projekt w Workbench za pomocg Ctrl + s
2.2. PRZYGOTOWANIA SIATKI NUMERYCZNEJ

1) W tym celu otworz program Ansys Meshing przez dwukrotne klikniecie LPM
Mesh
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Lx.: Microsoft OfficeExcel
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& Results
i System Coupling
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B vistaarD
M vistaCD
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T View All [ Customize. ..
I: Starting Meshing.- I
2) W programie Ansys Meshing: 1) kliknij Mesh, 2) Zmien pole Physisc
Preference na CFD, 3) Zmien pole Solver Preference na CFX, 4) Kliknij LPM
Generate Mesh
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A Mesh - Meshing [AMSYS Academic Research Mechanical and CFD]

ile Edit View Units Tocls Help | =+ :j Generate Mesh IE' E;h" [
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esh -7 Update | B Mesh » B Mesh Control + B Mesh Edit « | Alliretric €

QOutline

i

| Fi

lter:  Mame -
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| B Q=6 8
Project
..... @ Model (A3)

. ..... ﬁ Geometry
- I"-"Iaterlals

Details of "Mesh"

=

Display

Display Style |Use Geometry Setting

=

Defaults
Physics Preference | CFD 2 I

Solver Preference JCFX |—|

Element Crder Linearl 3 I

Element Size Defaulf fg,uﬁde-d}ﬂi m}

Sizing

Quality

Inflation

Advanced

F [ H B [H

Statistics

Domyslna siatka nie jest poprawna. Siatke nalezy edytowac.



0,000 5,000 10,000 ()

Messages
| Association

Error
Error

FEnmor |

Text
One or more entities failed to mesh. The mesh of the bodies containing these entities may not be up-to- Project>Model>Geometry>SYS Bodies>SYS\Solid

One or more surfaces cannot be meshed with acceptable quality. Try using a different element size or vir Project>Model>Geometry>SYS Bodies>SYS\Solid
| A mesh could not be generated using the current meshing options and settings. Project>Model>Mesh

3) K|Iknlj PPM na Mesh i wybierz Insert->Method



ﬂ E h Context A : Mesh - Meshin

Home Mesh Display Selection Automation

g 8 Named Selection (@) Images ~ ‘1 a

s Coordinate System E.Secucn Plane

% Cut X Delete

[JComment [ Annotation
Insert

aQ®we s C-aae@

Name ¥ | Search Qutline | ™ +
1 project*
B Model (A3)
-----,@a Geometry
@ Materials

. ----- 1 Coordinate Systems
-y [

Generate Unfts Workshest Kd

Insert 4 Method
=3 .
2~| Update P sizin
? 9| Method
]
$  Generate Mesh A1 e Control the algorithm and
Preview y A Refinem \'b mesh types used to generate
meshes on scoped entities.
Show » @ FaceMsd
Details of "Mesh" %  Create Pinch Controls B MeshCd (1) press F1 for help.
-/ Display 5 Group All Similar Children 8@ Match Cormon
—Display Style &  Clear Generated Data ® Pinch
-|| Defaults cen " §  Inflation
——— a|b ame
Physics Preferenc . @ Mesh Edit
Solver Preference Start Recording )
= Mesh Numbering
Element Order Linear
Element Size | Default (1,0817 m) {8 contactMatch Group
7| sizing @ Contact Match
| Quality 8] Node Merge Group
/| Inflation $. Node Merge
H] Advanced @ Node Move
+| Statistics

Control the algorithm and mesh types used to generate meshes on scoped entities.
4) LPM wskaz calg bryle i zatwierdz Apply w polu Geometry
atails of "Automatic Method" - Metho v 1 [ X

Scope
Scoping Method | Geometry Selection
eome Apply Cancel
Definition
Suppressed No
Method Automatic

Element Order Use Global Setting




5) Zastosuj ponizsze ustawienia

6) Kliknij PPM na Mesh i wybierz Insert->Sizing

Name ¥ | Search Outline | ™

7)

Il Project*
----- Model (A3)

(- @@ Geometry
/{8 Materials
B, 24 Coordinate Systems

oo [

tails of "Mesh"
Display
Display Style
Defaults ¥
Physics Preference &
Solver Preference 4>
EWnt Order aIb
Element Size

Sizing

Insert
Update

Generate Mesh

Preview

Show

Create Pinch Controls
Group All Similar Children
Clear Generated Data

Rename

Start Recording

Details of "MultiZone" - Method ~ 00O
Scope
Scoping Method Geometry Selection
Geometry 1 Body
Definition
Suppressed No
Method MultiZone
Mapped Mesh Type Hexa/Prism
Surface Mesh Method Program Controlled
Free Mesh Type Not Allowed
Element Order Use Global Setting
Src/Trg Selection Automatic
Source Scoping Method | Program Controlled
Source Program Controlled
Sweep Size Behavior Sweep Element Size
| Sweep Element Size | Default

4

&G

F2

Quality

Inflation

Advanced

Statistics

¢ 2 §E FDIEL B B

Sizing

'

Face Mesh
Mesh Cop|

Control size-related settings such as element
size, number of divisions along an edge, use of
sphere or body of influence, minimum size, etc.

Match Cor
Pinch

(D Press F1 for help.

Inflation
Mesh Edit
Mesh Numbering

Contact Match Group
Contact Match

Node Merge Group
Node Merge

Node Move

0,000

Zmien filtr wyboru na krawedzie (skrot Ctrl + E) i wskaz krawedz jak na

rysunku
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8) Zastosuj ponizsze ustawienia

=

Details of "Edge Sizing" - Sizing v3Ox
Scope
Scoping Method Geometry Selection
Geometry 1 Edge
Definition
Suppressed No
Type Number of Divisions
| Number of Divisions | 150
Advanced
Behavior m
Capture Curvature No
Capture Proximity No
Bias Type oo
Bias Option Bias Factor
| Bias Factor 100, |
Reverse Bias No Selection

Blree® ® =2 B

9) Podobnie wstaw Sizing dla krawedzi przy krawedzi sptywowej pokazanych

ponizej
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10) Zastosuj ponizsze ustawienia

Scope
Scoping Method - Geometry Selection
Geometry 2 Edges
Definition
Suppressed No
Type Number of Divisions
Number of Divisions hl
Advanced
Behavior Hard
Capture Curvature No
Capture Proximity No
- Bias Type ' No Bias

i nacisnij Generate Mesh.

11) Ostatni krok to nadanie nazw obj¢tosciom i powierzchniom. Za pomocg Create
Named Selection nadaj nast¢pujace nazwy (jesli nie pamiegtasz jak uzywaé
Create Named Selection sprawdz w poprzednich instrukcjach):

a. Objetos¢ bryty — Fluid_domain
b. Powierzchnia wlotowa (powierzchnia cylindryczna) — inlet



c. Powierzchnie symetrii (z dwdch stron) — sym

2,500

d. Powierzchnia ptata — airfoil

e. Powierzchnia wylotowa (pozostate powierzchni) — outlet
12) Zamknij modut Ansys Meshing i zapisz projekt w Workbench.



2.3. PRZYGOTOWANIE MODELU NUMERYCZNEGO

1) Wstaw modut CFX

E Analysis Systems

E Design Assessment
Eigenvalue Buckling
8] Electric

BN Explicit Dynamics
& Fluid Flow (CFX)

{3 Fluid Flow (Fluent)
k] HarmonicAcousts
(¥ HarmonicResponse
ﬁ IC Engine (Fluent)
@ Magnetostatic

B Modal

Bl Medal Acoustics

il Randemvibration
El Response Spectum
ﬁ Rigid Dynamis

Ll staticAcoustis

B3 Static Structural

) Steady-State Thermal
) Thermal-Elactric

(£ Topology Optimization
fzd Transient Structural
Transient Thermal
@ Turbomachinery Fluid Flow

Create standalone system

[E{.‘.umpnnent Systams

iy AcCP (Post)
iy ACP (Pre)
fid BladeGen

(@ o

g Engineering Data
ﬂ External Data
g Sxternal Model
Flugnt

Fluent (with EMent Meshing)
B Geometry

W celu potagczenia modutu Mesh z CFX chwy¢ LPM Mesh (to nizej) i
przeciagnij na Setup az do pojawienia si¢ pola Transfer A3, a nast¢pnie pusé
LPM — potaczenie zostalo utworzone

A

Geometry '

v
1
2
3

@ Mesh

v J

Mesh

-

1

2 Transfer A3

3 | @) soluton P

4 9 Results % P
CFX

Kliknij PPM na Mesh i wybierz Update



Geometry "

2
3| @ Mesh

Mesh

Duplicate
Transfer Data From Mew »
Transfer Data To New 3

Update

Update Upstream Components
Clear Generated Data

Refresh

Reset

Rename

Properties

Quick Help
Add Mote

Kliknij dwukrotnie Setup w celu uruchomienia programu Ansys CFX
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& Fluid Flow (cFx) 3 @ Mesh v 4 3 ﬁ Soluton F
B Fluid Flow (Fluent)
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fE Modal
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m Random Vibraton
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] StaticAcoustis

B Static Structural
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£ Topology Optimzston
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B3 Turbomachinery Fluid Flow
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g Engineering Data
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@ External Model

EX Fluent

B2} Fluent (with Fluent Meshing)

ﬁ Geometny

B 1cemcFD

i@ Material Designer

I\ Mechanical arDL

@@ Mechanical Model

ﬁ Mesh

[ Microsoft OfficeExcel

€5 Performance Map

& Results

System Coupling

&3 Turho Setup

B vista AFD

MR vista CCD

B visia CPD -

2) Otworz Analysis Type przez dwukrotne kliknigcie LPM



hd [EI Mesh
& sys.cmdb
5| Connectivity
hd @ Simulation
~ [ Flow Analysis 1
v || Default Domain
M ¥ Default Domain Default

Zastosuj nastepujace ustawienia i zatwierdz OK.

Outline Analysis Type
Details of Amalysis Type in Flow Analysis 1

Basic Settings
AMSYS MultiField Coupling

Option Maone

Analysis Type

Optian Steady smg

3) KIliknij dwukrotnie LPM Default Domain
¥ @ Mesh

&1 sys.cmdb
G Connectivity
hd [EI Simulation
v [ Flow Analysis 1

(D Analysis Type

b Default Domain

[“19% Default Domain Default

i:ﬂ Interfaces

Zastosuj nastepujace ustawienia




Outline  Domain: Default Domain
Details of Default Domain in Flow Analysis 1

Basic Settings | Fluid Models  Initialization = Solver Control

Location and Type

Location |FIuid_domain | v
Domain Type Fluid Domain -
Coordinate Frame Coord 0 -
Fluid and Particle Definitions... =)
Fluid 1
L]
X
Fluid 1 =
Option Material Library -
Material |] Air Ideal Gas | ~
Morphology B
Option Continuous Fluid -
(] Minimum Volume Fraction

Domain Models
Pressure =

Reference Pressure \1 [atm]

Outline Domain: Default Domain
Details of Default Domain in Flow Analysis 1

Basic Settings | Fluid Models | Initialization  Solver Control

Heat Transfer S|

Option Total Energy -

Incl. Viscous Work Term

Turbulence =
Option Shear Stress Transport -
Wall Function Automatic -

[ High Speed (compressible) Wall Heat Transfer Model
] Blended Near Wall Treatment (Beta)
[] Turbulent Flux Closure for Heat Transfer
[] Transitional Turbulence
Advanced Turbulence Control

HEHEA

Combustion =
Option None -
Thermal Radiation =]
Option None -

] Electromagnetic Model =



4) Utworz expression 0 nazwie Re o ponizszej definicji
Details of Re

Definition Plot Evaluate

50000|

5) Utworz expression o nazwie chord o ponizszej definicji
Details of chord

Definition Plot Evaluate

1/mj

6) Utworz expression o nazwie ulnlet o ponizszej definicji
Details of uInlet

Definition Plot Evaluate

Re™ Dynamic Viscosityf choxd/ Density

7) Utworz warunek brzegowy o nazwie inlet

F FgEl

Insert Bound...

Mame |inleﬂ

8) Zastosuj ponizsze ustawienia

Qutline Boundary: inlet
Details of inlet in Default Domain in Flow Analysis 1

Basic Settings Boundary Details Fluid Values Sources Plot Options

Boundary Type I Inlet I -

Location I inlet I W

[] Coordinate Frame




Qutline  Boundary: inlet
Details of inlet in Default Domain in Flow Analysis 1

Basic Settings | Boundary Details | Sources  Plot Options

Flow Regime B
Option Subsonic -
Mass And Momentum B
Option Cart. Vel. Components A

U ulnlet |

v 0[ms™-1] |

w 0[ms™1] |

[] Acoustic Reflectivity (Beta)

Turbulence =]
Option Medium (Intensity = 5%) -

Heat Transfer B
Option Static Temperature -

Static Temperature 20 [C] |

9) Utworz warunek brzegowy outlet i zastosuj ponizsze ustawienia
Qutline  Boundary: outlet
Details of outlet in Default Domain in Flow Analysis 1

Basic Settings | Boundary Details  Sources  Plot Options

Boundary Type Opening -

Location outlet w

[] Coordinate Frame




Qutline  Boundary: outlet 8
Details of outlet in Default Domain in Flow Analysis 1

Basic Settings | Boundary Details | Sources  Plot Options

Flow Regime =
Option Subsonic -
Mass And Momentum =
Option Opening Pres. and Dirn -
Relative Pressure lo [Pa] |
[] Acoustic Reflectivity (Beta)

Flow Direction =i
Option Mormal to Boundary Condition -

] Loss Coefficient
Turbulence =
Option Medium (Intensity = 5%) <

Heat Transfer =
Option Opening Temperature v

Opening Temperature |2l] [C] |

10) Utworz warunek brzegowy sym i zastosuj ponizsze ustawienia

Outline  Boundary: sym
Details of sym in Default Domain in Flow Analysis 1

Basic Settings

Location | sym | v

11) Utworz warunek brzegowy airfoil i zastosuj ponizsze ustawienia
QOutline  Boundary: airfoil
Details of airfoil in Default Domain in Flow Analysis 1

Basic Settings Boundary Details Sources

Location I airfoil | “

[] Coordinate Frame



Outline  Boundary: airfoil (X
Details of airfoil in Default Domain in Flow Analysis 1

Basic Settings ~ Boundary Details ~ Sources

Mass And Momentum =]
(] wall Velocity
(] Turbulent Wall Functions (Beta)

Wall Roughness =]

Option Smooth Wall -

Heat Transfer =]

Option Adiabatic -

12) Utwoérz punkt monitorujgcy zawierajgcy expression o nast¢pujgcej definicji:
arealnt(Wall Shear)@airfoil
13) Otworz Solver Control i zastosuj ponizsze ustawienia
Outline

b @ Mesh
& sys.cmdb
@ Connectivity
b [EI Simulation
v |8 Flow Analysis 1
(D Analysis Type
v [v] & Default Domain
1% Default Domain Default
[PE inlet
ii outlet1
i$ outlet2
ﬁﬂ Interfaces
e Solver
&' Solution Units

EEG|".«'EF Control
Output Control
;gt. Coordinate Frames
User Locations
Transformations
@ Materials
@ Reactions



Outline  Solver Control (%
Details of Solver Control in Flow Analysis 1

| Basic Settings | Equation Class Settings ~ Advanced Options

Advection Scheme ~
Option High Resolution -
Turbulence Numerics =
Option High Resolution -
Convergence Control
Min. Iterations 10000 |
Max. Tterations 10000| 1

Fluid Timescale Control B
Timescale Control Auto Timescale -

Length Scale Option Conservative -

Timescale Factor 1.0

[] Maximum Timescale

Convergence Criteria
Residual Type RMS -
Residual Target 1.E-4

[] Conservation Target

[] Elapsed Wall Clock Time Cantraol
Interrupt Control =

W

14) Zamknij program Ansys CFX.

2.4. OBLICZENIA
1) Kliknij dwukrotnie pole Solution w celu uruchomienia programu Ansys CFX
Solver Manager



| Bl Analysis Systems I ~
Design Assessment )
Eigenvalue Buckling - A - B

e i~ - W0

Explicit Dynamics 2 Geometry "

-/—c 2 @ sewp
Fluid Flow (CFX) 3 @ Mesh v . Sclution i
Fluid Flow (Fluent) -
Harmonic Acoushcs Mesh 4 9 Resmilts & 4
Harmonic Response CFX

IC Engine (Fluent)
Magnetostatic

Madal

Modal Acoustics
Random Vibration
Response Spectrum
Rigid Dynamics
StaticAcoustics
Static Structural
Steady-State Thermal
Thermal-Electric
Topology Optimization -
& Transient Structural A

OECOEECECENRERREEE®

ﬂ Transient Thermal 1 Type

) ) Turbomachinery FluidFlow
|E| Component Systems

iy ACP(Post)

i ACP(Pre)

ﬁ‘ BladeGen

@) CFx

Q Engineering Data
External Data

@ Extemnal Model

E Fluent

n Fluent (with Fluent Meshing)
@ Geomety

ICEM CFD

Material Designer
Mechanical APDL
Mechanical Modal
Mesh

Microsoft Office Bxcel
Performance Map
Results

System Coupling
Turbo Setup

M vistaAFD

M vistaCD

B vista PR l

| T View All / Customize. ., |

I : Starting CFX-SolverManager... I

0emeesSsE

@

2) Zastosuj ponizsze ustawienia i nacisnij Start Run. Program wykona obliczenia.
Zaczekaj kilka chwil na komunikat o zakonczeniu obliczen.



& Define Run ? *

Solver Input File NCwS\Cw5_files\dpO\CFX\CFX\CFX.def | | |
Global Fun Settings
Run Definition Initial Values
Run Settings

Type of Run Full -

Double Precisiunl
[] Large Problem

Parallel Environment =
Run Mode Intel MPI Local Parallel -
Host Name Partitions

desktop-1erkcpo 4

[ ] show Advanced Controls

Start Run Save Settings Cancel

3) Obliczenia trwaja okoto 2 minut. Obserwuj poszczegélne zaktadki rezidut jak
si¢ zmieniajg. Szczegdlnie zwr6¢ uwage na zaktadke User Point, gdzie
pokazana jest sita $Scinajaca na profilu. Stan ustalony bedzie osiagnicty, gdy
krzywa ustabilizuje sig, co nastapi po okoto 100 iteracjach. Dodatkowe iteracje
powinny by¢ wykonane az do ustabilizowania si¢ wszystkich rezidut. W celu
wczesniejszego zatrymania naci$nij przycisk Stop u gory ekranu i potwierdZ
Yes.



%%y e Ry BEREED @ xer mE x>

Workspace Run CFX 001

-

tum and Mass ~ Heat Transfer ~ Turbulence (KO)  Wall and Boundary Scale  User Points 4 B3 OutFile
0.0012 —
i Total
7] S
| Job Infi
0.001 R,
] s} Ust
0.0008 4 A
CFX_001 has terminated at user's request. 2l N
o - o Run concluded at: czw. maj 14 15:24:20 2020 v
§ J Results are in
@ 0.0006 - D:/USUN/Cw7/Cw7_files/dp0/CFX/CFX/CFX_001.res v
20
2 7 Open this workspace now
T _ p
>
oK
0.0004 —
| The results from this run
T | written to D:/USUN/Cw7/Cw
e
0.0002 —
4 et
| For CFX runs launched fro
o | directories and files gen
1 T T T T e e L Bt
0 50 100 150 200
Accumulated Time Step
| — Monitor Point: ShearForce [N] | This run of the RNSYS CEX 3o

4) Po skonczeniu obliczen program wyswietli komunikat potwierdzajacy.
5) Zatwierdz OK 1 zamknij Ansys CFX Solver Manager. Zapisz projekt

w Workbench.

2.5. OPRACOWANIE WYNIKOW

1) KIliknij dwukrotnie LPM Results w celu uruchomienia programu Ansys CFD

Post i obejrzenia wynikow



Toobox

| Bl Analysis Systems

4 Design Assessment

#3 EBgenvaluzBuckling - A = B

[ Elecric
Explicit Dynamic
£ Fluid Flow (CFX)

@ Fluid Flow (Fluent)

5§ HarmonicAcoustics Mesh I Reslts & !

(@ HarmonicResponse
ﬁ IC Engine (Fluent)
(0] Magnetostatc

@ mModal

) Modal Acoustics
[y RandomVibration
iy ResponseSpectum
Ezd Rigid Dynamics
& staticAcoustics
e Static Structural
u Steady-State Thermal

m Thermal-Electric
& Topology Optimition Messsges |

@ Transient Structural A

Transient Thermal 1 Type

g3 Turbomachinery FluidFlow
| B Component Systems

iz ACP(Post)

:lz ACP(Pre)

ﬁ BladeGen

@ CFx

& Engineering Dafa
External Data

9 External Model

E Fluent

ﬂ Fluent (with Fluent Meshing)
@ Geometry

ICEM CFD

@%@ Material Designer
N Mechanical APDL
@ Mechanical Model
@ Mesh

lﬁ' Micros oft Office Excel
& Performance Map
& Resulis

(] System Coupling
€5 Turbo Setup

B vista AFD

M vistacD

B vistacPn w

| T View All [ Customize.., l

| ® starting CFD-Post..

2) Utworz ptaszczyzne prostopadia do profilu (rownolegla do powierzchni sym)

| pokaz kontury

P00 T

Cisnienia — Pressure

Cisnienia absolutnego — Absolute Pressure
Cisnienia catkowitego — Total Pressure
Predkosci — Velocity

Liczby Macha — Mach Number

Gestosci — Density



3)

4)
5)
6)
7)

g. Temperatury — Temperature

h. Calkowitej temperatury — Total temperature

i. Turbulentnej energii kinetycznej — Turbulence Kinetic Energy

J.  Turbulentnej dyssypacji energii — Turbulence Eddy Dissipation
Wykorzystujgc funkcje areaAve oblicz w tabeli:

a. Wartosc¢ predkosci na wlocie

b. Warto$¢ strumienia masy na wlocie

c. Wartos¢ $redniej temperatury na powierzchni airfoil

d. Wartos¢ érednig zmiennej Yplus
Pokaz kontury zmiennej Yplus na powierzchni airfoil
Wyswietl linie pradu na poprzednio utworzonej ptaszczyznie
*Oblicz wspotczynniki oporu i unoszenia dla badanego ptata
Wr6¢ do Ansys CFX Pre i zmien warto$¢ expression Re na wartos¢ 500 000
i powtdrz obliczenia oraz wykonaj punkty 2)-6). Nast¢pnie dla Re =5 000 000.

3. WYNIKI JAKIE NALEZY UMIESCIC W RAPORCIE

1)

2)

3)
4)
5)

Dla wartosci Re = 50 000, 500 000 oraz 5000 000 (Uwaga: jesli to mozliwe
wyniki najlepiej zestawia¢ ze sobag w celu poréwnania; np. Rys. 1. Rozktad
ci$nienia w plaszczyznie prostopadlej do ptata, a) Re = 50000, b) Re =
500 000, ¢) Re =5 000 000):
Kontury w ptaszczyznie rownolegtej do powierzchni sym:
Ci$nienia — Pressure
Cisnienia absolutnego — Absolute Pressure
Cisnienia catkowitego — Total Pressure
Predkosci — Velocity
Liczby Macha — Mach Number
Gestosci — Density
Temperatury — Temperature
Calkowitej temperatury — Total temperature
Turbulentnej energii kinetycznej — Turbulence Kinetic Energy
J.  Turbulentnej dyssypacji energii — Turbulence Eddy Dissipation
W tabeli umiesci¢ wyniki:
a. Sredniej predkosci na wlocie
b. $redniego strumienia masy na wlocie
C. sredniej temperatury na powierzchni airfoil
d. sredniej wartosci zmiennej Yplus
Zdjgcie konturéw zmiennej Yplus na powierzchni airfoil
Zdjecie linii pradu
Odpowiedzie¢ na pytanie: Na podstawie analizy wartosci zmiennej Yplus, czy
zastosowany model turbulencji SST zostat wybrany poprawnie?

—mSQ@ P a0 o

4, ZADANIA NIEOBOWIAZKOWE

1. Wykonaj obliczenia przy pomocy innego modelu turbulencji i poréwnaj wyniki.

2. Wr6¢ do modutu Meshing i zaggsc siatke (szczegdlnie przy powierzchni airfoil).
Zwigksz ilo$¢ elementow takze na innych krawedziach. Sprawdz jaki to ma wplyw
na obliczenia i na warto$¢ zmiennej Yplus.

5. LITERATURA
[1] https://www.youtube.com/watch?v=xkEvS5eafCg&t=6s Dostep: 15.05.2020 r.
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